
M1 Battery Replacement / Reinstall Sounds 

The M1 uses a CR-2032 lithium battery to hold sounds, sequences, drum 

kits, and global settings in memory. When "Battery Low (Internal)" or "Init 

Program" appears in the M1's display, the internal battery must be 

replaced. When the battery goes dead or a new battery is installed, all 

sounds and previous data in the internal memory are lost. 

If the M1 and computer are not MIDI connected, the only way to restore 

this data is with a $100 US blank MCR-03 RAM card containing your 

backup, or a $50 US Factory Sounds ROM card from Voice Crystal, or at a 

local musical instrument store that services Korg products. 

If the M1 and computer are MIDI connected, use a utility program to 

transfer the "Factory" backup file in the prog/combi download to restore 

the original sounds, drum kits, and global settings. The "Factory" sounds 

are also a free download directly from KorgUK. 

to install the m1 battery: ...(photos) ...(video) 
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http://www.voicecrystal.com/korg.htm
http://www.korg.co.uk/support/downloads/m1_dl.php
http://www.google.com/search?hl=en&q=Korg+M1+battery&bav=on.2,or.r_gc.r_pw.r_qf.&biw=1024&bih=506&wrapid=tlif134949104248110&um=1&ie=UTF-8&tbm=isch&source=og&sa=N&tab=wi&ei=a5lvUPXzLITFiwKh_IGgCA
http://www.youtube.com/watch?v=Ta3ADqR7U8M


 

1. Unplug power and all cables to M1. 

2. Turn M1 upside-down on padding with keys to back, no weight on 

joystick. 

3. Unscrew and remove bottom plate. Battery is on the underside of 

the larger processor board. Ground yourself by touching something 

metal before touching inside keyboard. 

4. Unscrew board. Carefully detach its two 4-wire connectors (gently 

pull straight up). Tilt board back on to a towel exposing battery. 

5. Push old battery out of holder (spring loaded), noting its + side 

orientation up. 

6. Insert new CR-2032 battery in same orientation. 

7. Reassemble processor board, connectors, and bottom plate. 

8. Plug in and power on M1. "Init Program" appears in M1's display. 

9. Set MIDI to "Enable": GLOBAL, 5, +, UP, D, UP, F, UP, H, UP. 

10. Set memory protects to "Off": GLOBAL, 6, DOWN, +, B, DOWN, 

+, B, DOWN. 

11. Sysex transfer original factory sounds from a "Factory" backup file 

with a MIDI interface. 

...................................................................... 

RAM Memory Card Battery Replacement 

The M1's MCR-03 RAM memory card uses a CR-2016 lithium battery to 

preserve its data for about one year. When the battery goes dead or a new 

battery is installed, all data in the card is lost. 
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http://rover.ebay.com/rover/1/711-53200-19255-0/1?type=4&campid=5335880568&toolid=10001&customid=&mpre=http%3A%2F%2Fsearch.ebay.com%2FKorg-M1_W0QQfsopZ1QQsatitleZQ22KorgQ20M1Q22


A trick to replace the battery without losing the card's data is to power on 

the M1 and insert the card into the top slot first, thereby using the M1's 

power to preserve card contents while swapping batteries. 

The M1's display indicates when a RAM card's battery is low. 

A RAM card has three memory partition options, the PROG/COMBI 

option is recommended when using the card as a Factory sounds backup. 

RAM card details are in the M1 manual pgs 16, 119-121. 

to install the ram card battery: 

1. Power on M1, insert RAM card into top slot. (to preserve card 

contents) 

2. Slide out battery holder, noting battery's + side orientation. 

3. Insert new CR-2016 battery in same orientation into holder. 

4. Slide battery holder back into RAM card. (card may now be 

removed) 

5. Slide write protect switch to "ON" to protect existing data on card, 

or slide write protect switch to "OFF" to save new data to card. 

6. Load From Card: GLOBAL, 8, DOWN, G, G. (PROG/COMBI 

recommended) or Format Card(erases card data): GLOBAL, 9, +, 

DOWN, G, G. (100PROG/100COMBI recommended) or Save To 

Card: GLOBAL, 9, DOWN, G, G. (PROG/COMBI recommended) 

...................................................................... 

How To Use MIDI-OX Sysex Utility 

 

MIDI-OX is a free but complex Win XP to Win 7 sysex utility. It sends a 

sysex sound file (a bank of up to 100 sounds) from PC to M1 and receives 

a sysex sound file from M1 to PC (for storing) through a USB MIDI 

interface. 

http://www.midiox.com/


First, the MIDI interface must be connected and a driver installed for 

MIDI-OX to work. 

Next, prepare the M1 for sysex file transfers from the "Just Bought A Used 

M1?" section below. This is a one-time task. Alert: sending a sysex sound 

file from PC to M1 deletes and replaces any existing sounds already in the 

M1. 

Finally, in MIDI-OX, follow these steps. (The MIDI interface must be 

connected.) 

1. Configure MIDI setup: Options > MIDI Devices, click to hilite 

your MIDI Interface in the Input and Output sections. 

2. Save MIDI setup: type a name for the setup and click disk icon to 

save. Click OK. 

3. Enable sysex: Options > check Pass Sysex. 

4. Receive sysex bank from M1 (if saving existing sounds in M1): 

View > Sysex > Sysex > Receive Manual Dump. MIDI-OX will 

wait while you go to the M1 and press GLOBAL, 7, UP until ALL 

DATA is visible in the display, G. Save the dump as binary (.syx) 

NOT plain text. 

5. Send sysex bank to M1: Click first icon in toolbar, or (Actions > 

Send > Sysex File), or (View > Sysex > File > Send Sysex File). 

6. Receive or Send unsuccessful? Try increasing delays: View > 

Sysex > Sysex > Configure, try increasing delay between buffers 

from 60 to 100ms, or try increasing delay after F7 from 60 to 

100ms. Buffer delays help older slower equipment process data 

properly. 

...................................................................... 

Korg’s Two-Card Sets 

Korg no longer makes or sells M1 MPC/MSC ROM card sets. Most of the 

sounds from the MPC card inserted in the top slot require the 

corresponding MSC card with new PCM waveforms inserted in the rear 

slot. 

The Korg branded two-card sets are: 01-(no title), 02-Synth1, 03-Drums, 

04-Orchestra, 05-Piano, 06-Fretted Instruments, 07-Synth2, 08-Percussion, 

09-Organ, 10-Ethnic, 11-Brass, 12-Synth3, 13-Ethnic2, 14-SoundEffects, 

15-Drums2, 16-Environment. 

Used Korg ROM card sets occasionally appear on eBay. Buy Korg branded 

cards on eBay only as mated two-card sets; a single card is useless without 

its MPC/MSC corresponding mate. 

...................................................................... 

Internal Sequencer 

http://rover.ebay.com/rover/1/711-53200-19255-0/1?type=4&campid=5335880568&toolid=10001&customid=&mpre=http%3A%2F%2Fsearch.ebay.com%2FKorg-M1_W0QQfsopZ1QQsatitleZQ22KorgQ20M1Q22


The internal 8-track sequencer records and plays back songs numbered 0 to 

9. A song can have 1 to 8 tracks. A track can have 1 program. Combis can't 

be recorded with a sequencer. A track's program assignment can be 

changed within a song. Sequencer effect settings override the individual 

effect settings of each program. The length of a song is limited to 250 

measures. The size of a song is limited to 4,200 events (100progs/combis) 

or 7,700 events (50progs/combis). 

A sequencer doesn't record the sound like a tape recorder, it records the 

hexidecimal number parameters generated when you press keys. Programs 

used in a recorded sequence must be in the M1 in their previous slot 

assignments for the sequence to play properly. 

to play a sequence: 

SEQ, B, UP/DOWN (select song0-9 to play), START/STOP. 

to erase an old sequence: 

SEQ, 3, +, UP/DOWN (select song0-9 to erase), G, G. 

to record a new sequence: 

(Set aftertouch to "Disabled" to increase notes per track: GLOBAL, 5, +, 

D, DOWN.) 

1. SEQ, 0, B, UP/DOWN (select song0-9 to record). 

2. C, UP/DOWN (select track1 to record). 

3. F, UP/DOWN (select internal program00-99 to record on track1). 

4. REC, START/STOP (begin at measure M002). 

5. H, START/STOP (play track1). 

6. C, UP/DOWN (select track2 to record). 

7. F, UP/DOWN (select internal program00-99 to record on track2). 

8. REC, START/STOP (begin at measure M002). 

9. H, START/STOP (play track1-2). 

to restore sequencer memory back to 100%: 

Press SEQ. If there's less than 100%Free in the display, this trick will 

quickly erase all current sequencer songs and sequencer patterns, restoring 

100% available memory. (also erases progs and combis in slots 50-99, so 

backup first.) 

1. Set Memory Allocation to 50prog/50combi/7700seq: GLOBAL, 6, 

+, +, +, UP, G. 

2. Check sequencer memory: SEQ. If >35%Free: REC, play keys until 

<35%Free. 

3. Set Memory Allocation to 100prog/100combi/4400seq: GLOBAL, 

6, +, +, +, DOWN, G. 

4. Check sequencer memory: SEQ. Should be 100%Free. Reload 

programs and combinations. 

...................................................................... 



External Software Sequencer 

An external software sequencer can also record/play only programs in 8 

tracks. Combis can't be recorded with a software sequencer. The M1's 

clock must be manually set to "External" for every recording session with 

an external sequencer: GLOBAL, 5, D, UP (defaults back to "Internal" 

when the M1 is turned on). 

The M1 must be in sequencer mode to record/play more than one sound 

with an external sequencer, because only SEQ mode allows MIDI data 

exchange over all eight channels simultaneously. When a new channel for 

recording is selected in the external sequencer, the corresponding channel 

on the M1 must be set manually: SEQ, C, UP/DOWN (select 

track/channel1-8). 

Why use an external sequencer? Editing recorded tracks is easier and it's 

better for recording long songs. 

...................................................................... 

Sticky Keys 

The white lithium grease on the metal strip "springs" under the keys 

thickens and dries out over time. Unfortunately, the only way to re-grease 

sticky keys is to literally take the M1 apart to reach the metal strips. This is 

a daunting task, far more difficult than replacing the battery, and may best 

be done by a local musical instrument store that sells and services Korg 

products. 

Try the "jiggle" trick first. With the M1 off, press and hold down the keys 

adjacent to the sticky key. Grasp the sticky one with the other hand and 

rapidly move it up and down pushed to the left and right. The idea is to stir 

up the dried grease making it softer. 

If determined to do-it-yourself, there's a link below on keyboard repair. 

...................................................................... 

Just Bought A Used M1? 

on your m1... 

 Make M1 MIDI ready: GLOBAL, 5, +, UP, D, UP, F, UP, H, UP. 

 Remove memory protects: GLOBAL, 6, DOWN, +, B, DOWN, +, 

B, DOWN. 

 Put M1 in 100/100 memory: GLOBAL, 6, +, +, +, DOWN, G. 

 Check M1 is working: PROG, 00. Check volume.  Play keyboard 

with headphones. 



data dump from m1 to computer... 

 From the software sysex utility or librarian's File menu look for 

"New..." or "New Bank..." to open a blank sound bank file. 

 Click a "Receive" or "Capture" button to receive the M1's sound 

bank through your MIDI interface into the computer. 

 The program will wait while you manually send the data dump 

from M1 to computer: GLOBAL, 7, UP, UP, UP, UP (for "All"), G. 

send data from computer to m1... 

 From the software sysex utility or librarian's File menu look for 

"Open..." or "Open Other..." or "Open Any..." to open an existing 

sysex sound bank file. 

 Click a "Send" or "Transmit" button to send the sound bank through 

your MIDI interface into the M1. 

 Click the M1's "UP" button, then the "DOWN" button. The first 00 

sound of the new bank should be visible in the display. 

...................................................................... 

Frequently Used Keyboard Commands 

 Data Dump From M1->PC: GLOBAL, 7, UP/DOWN (select file 

type), G. 

 Select Internal <-> External Sequencer: GLOBAL, 5, D, 

UP/DOWN (select). 

 Disable Aftertouch: GLOBAL, 5, +, D, DOWN. 

 Erase Sequencer Song: SEQ, 3, +, UP/DOWN (select song), G, G. 

 Erase Sequencer Track: SEQ, 4, +, +, UP/DOWN (select track), G, 

G. 

 Load From Card: GLOBAL, 8, DOWN, G, G. 

 Transpose: GLOBAL, +, F, UP/DOWN (+12 = +1 octave, 00 = 

default, -12 = -1 octave.) 

...................................................................... 

M1 Links 

eBay has M1 stuff for sale right now. Check it out. 

KorgUK has a free download of the M1's original Factory sounds and 

manual. 

Patchman Music has Mac & PC sysex utilities for free download. 

Do-It-Yourself keyboard repair FAQ, or contact a local musical instrument 

store. 

Voice Crystal sounds: $80 ROM card, $50 Factory ROM card, $100 blank 

RAM card. 

Greytsounds sounds: $70 ROM card, $13 e-mail. 

Pro-Rec sounds: $70 ROM card, $40 email. 

Kid Nepro sounds: $30 email. 

http://rover.ebay.com/rover/1/711-53200-19255-0/1?type=4&campid=5335880568&toolid=10001&customid=&mpre=http%3A%2F%2Fsearch.ebay.com%2FKorg-M1_W0QQfsopZ1QQsatitleZQ22KorgQ20M1Q22
http://www.korg.co.uk/support/downloads/m1_dl.php
http://www.patchmanmusic.com/SysexUtilities.html
http://net.indra.com/~cliffcan/01keys.htm
http://www.voicecrystal.com/korg.htm
http://www.greytsounds.com/gs/ssi/ssi-korg2.html?CXT=aMhCA
http://www.pro-rec.com/M1.html
http://www.kidnepro.com/KN/Korg/Korg.html


ManyMidi sounds: $100 multi-disk sets. 

Zzounds has a selection of MIDI interfaces. 

MIDI-Store has a selection of MIDI interfaces. 

Kraftmusic has a selection of MIDI interfaces. 

...................................................................... 
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http://www.manymidi.com/m1.html
http://www.zzounds.com/cat--MIDI-Interfaces--2429
http://www.midi-store.com/Midi-Interfaces-p-1-c-251.html
http://www.kraftmusic.com/sitesearch/?q=MIDI-Interface

